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IntroductionImportant information
The Axicon veriier is a high precision opto-electronic device and should be handled 
carefully. Please keep and use the case to protect the veriier when it is not in use.

Only use power and data cables supplied by Axicon as the use of non-approved 

accessories will invalidate the warranty. If the veriier is dropped (or subjected 
to similar misuse) the accuracy of the results may be affected and it should be 

returned to Axicon immediately for servicing.

We recommend that the veriier is factory recalibrated annually to ensure that it 
remains compliant to ISO/IEC 15426-1. The unit should be returned to Axicon or to 

your approved Axicon reseller for this servicing.

Software updates are always available free of charge, and can be downloaded from 

our website, www.axicon.com

What is in the case.

One of the following veriiers:

• Axicon 6000 series veriier with USB cable.
• Axicon 6500 series veriier with USB cable.
• Axicon 7000 series veriier with USB cable.
• Software CD.

• Wallet containing this user guide and calibration sheet

The Axicon veriier is designed to work with any PC running a version of Microsoft 
Windows currently supported by Microsoft.
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When you reach the Select components to install window you will see the boxes 

alongside Drivers and Main Program have been preselected. If you want to use the 

Scan File data Extractor, select this option by ticking the box.

The Scan File Data Extractor enables you to summarise and record all the 

veriications made in a standalone database. It uses the data from the Axicon scan 
iles (those with a .scn extension) to create a complete record of all the iles that 
have been saved, either automatically or manually. More information about this is 
available via the website www.axicon.com.

Only tick the box alongside Inline Veriier if you know you will be using one of the 

Axicon S-range veriiers to check every barcode being printed on a production line.

Installation
Software installation. 

Insert the CD into the CD drive. The Install Program should run automatically (if 

not, open the CD using Windows Explorer and double-click the Autorun Program). 

Click Install Axicon Veriier and follow the installation instructions. 

At the Select Components to Install window ensure that the boxes relating to 

Drivers and Main Program are both ticked. After installation is completed you will 

ind the Axicon Veriier directory in Start Menu/Programs and a shortcut to the 

program on your desktop.

If you have downloaded the software from our website then simply click on the 

setup ile and follow the instructions. 

Hardware installation

Plug the veriier into any available USB port on the computer. For Windows 7 and 
Windows 8 installations the drivers should be installed automatically.

Note: Please follow these installation instructions in the correct order, namely 

installing the software before the veriier is plugged into any USB port. If the 
veriier is plugged in before the software has been installed, Windows will attempt 
to ind the correct drivers for the veriier via the internet, and choose an incorrect 
option. This then causes problems as the software is unable to install the correct 

driver.

Page 6 of 28 Page 7 of 28

Axicon Auto ID Limited  |  Linear veriier user guide | March 2016Axicon Auto ID Limited  |  Linear veriier user guide | March 2016

Axicon 6000, 6500, 7000 seriesAxicon 6000, 6500, 7000 series



Holding the veriier
The Axicon veriiers are all designed to be used with the veriier positioned so that 
it touches the barcode, as shown in the pictures opposite. 

Each veriier can be controlled via the software, and they also have a button to 
take a scan. The button on the 6000 series is underneath the read head. The 6500 

and 7000 series each have two buttons on the top. These have the same function so 

use whichever button is more convenient.

Wait for at least a minute after switching on the veriier (when the red LEDs will be 
illuminated) before using it. This allows the circuitry of the reader to stabilise.

It is important that the front lap of the 6500 or 7500 veriier is closed so that as 
much ambient light as possible is excluded from the veriication process.

If the code you are verifying is printed around the circumference of a curved 

surface, the varying distance of the reader from the code may produce inconsistent 

results.

Press the trigger button. The reader will beep and the data from the irst scan will 
be displayed in the software immediately. For full ISO/IEC veriication you should 
scan the barcode ten times, moving through its height and avoiding the top 10% and 

bottom 10%.

The Axicon 6000 series - All four 

corners of the veriier are touching 
the surface. The 6000 series veriier 
cannot be used for symbols wider 

than 66mm, and this dimension 

includes the quiet zones.

The 6500 series can be operated 

either horizontally or vertically (on 

the side of a carton) but always in 

contact with the barcode. The 6500 

series veriier cannot be used for 
symbols wider than 125mm, and this 

dimension includes the quiet zones.

The Axicon 7000 series is being 

placed lat onto the label with the 
barcode in the ield of view. The 7000 
series veriier cannot be used for 
symbols wider than 200mm, and this 

dimension includes the quiet zones.
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Getting started
When you irst start the software you will see the Command window and the 

Summary window. 

Information is also given on the: 

• bar gain (ink spread or bleed), 

• the size of the x-dimension (the width of the narrowest bars)

• validation of the check digit

• structure

• the quiet zones (the clear spaces or light margins each side of the barcode)

The Command window gives access to all of the main features of the veriier. Use 
the pull down menus or the icons to operate the software.

The Summary window shows the overall print quality of the barcode as 

measured by the ISO/IEC or ANSI standards.

Calibration
Calibration should be carried out 

after installation and at regular 

intervals. When the software detects 

an uncalibrated reader the following dialogue 

box will appear Reader XXXX has not been 

calibrated. You must click OK to continue. 

You will also need your calibration card which 

should be located in your documentation 

wallet. 

For the Axicon 6000 series use the EAN-13 

or UPC-A calibration code at the top of the 

card. For the Axicon 6500 and 7000 series use 

either of the large calibration codes at the 

bottom of the card.

Calibration is a quick and simple process. 

Select Calibrate from the Options menu 

of the command window (or press F2). You 

will see a window with two edit boxes for 

minimum and maximum relectance values. 
Ensure that the values shown in the window 

match the values printed at the bottom of 

the calibration card. Modify the igures on 
the window if necessary to ensure that they 

are the same as the card.

With the Calibration window open scan the 

calibration barcode 10 times. Then click the 

OK button. The veriier is now calibrated 
and ready to use. After calibration, store 

the calibration card in the documentation 

wallet, away from light and physical damage. 

If your calibration card should ever become 

damaged or discoloured, please contact Axicon or your supplier for a replacement. 
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Details

This window shows each of the 

ISO/IEC parameters that are 

measured and individually graded (as 

both grades and percentages). Seven 

parameters are graded and the lowest 

single grade becomes the overall grade 

for that scan. If the Summary window 

has shown poor print quality then the 

Details window is the ideal point to 

initially see what is wrong with the 

barcode.

Scan relectance proile
The scan relectance proile window shows you what the barcode will look 

like to a scanner. At the top of the graph are the higher levels of relectance from 
the background and at the bottom of the graph are the lower levels of relectance 
from the 

darker bars.
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Software windows
There are ive more windows you can open to look at the veriication results. Go 
to the View menu on the Command window, and the select the window you want, 

or use the icons that appear just below the menu headings. If you hold your mouse 
over each icon a brief description of its function will appear at the bottom left 

of the Command window. The four most important windows are briely described 
below.

Dimensional Analysis

If the Details window 

has shown a poor 

Decodability grade then 

this is normally because of 

bad dimensional accuracy 

– this screen will show the 

accuracy of the bar/space 

dimensions and highlight 

any problem areas.

Pass / Fail

This window is ideal 

for users who need 

a quick visual indication of 

whether the barcode meets 

the right print quality 

standards.

Rearranging the windows

Most of the windows described above can be moved, expanded or shrunk as 
required. When you have decided which windows you would like displayed on your 

PC just use the View pull-down menu and click on Save Positions. Then whenever 

the software is started it will always have those windows in those positions.

The help menu from the command window gives you access to context-sensitive 

help about the software. It also has a search function to ind relevant information. 
The F1 key can also be used as a shortcut to switch on this help.
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Continuous scan
The Axicon S range veriiers have 
a unique continuous scan feature. 

When irst installed this feature is 
automatically activated on start-up (but 

can be de-activated if required) and 

allows the user to get an assessment of 

the barcode quality in a fraction of the 

time that it would take with other linear 

veriiers. 

The veriier should be placed either just 
above or just below the barcode and the 
trigger pressed. With the trigger still 

pressed, move the veriier down the height 
of the barcode. The veriier will scan at 
the rate of 100 veriications a second until 
it reaches the bottom of the barcode (or 

gets to the maximum number of scans). 

The veriier will automatically calculate an 
average of the results of all of the scans 

to provide an overall quality grade based 

upon an assessment across the scanned 

bar height. 

When verifying barcodes on awkward 

shaped packaging you may ind it easier to 
switch off the Continuous scan mode. This 

feature can be activated or de-activated 

as required with a toggle switch on the 

Command window.
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6025-S

6525-S

7025-S

Selecting the veriier
If you have more than one veriier plugged into your computer at the same 
time (for example a 6015 and a 7015), you will need to choose which one you 

want to use. If the LEDs are not illuminated on the veriier you need, go to 
the Options menu on the Command window, and then choose Show Reader Info (or 

use the shortcut F3).

A new window, Reader info, will appear. 

At the bottom you see the button Enumerate. Click on this and in a few moments 

all the connected veriiers will be displayed as small icons. The irst four characters 
are the serial number of each veriier which is clearly marked on each one. Double 
click on the icon for the particular veriier you wish to activate.
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Setup
All of the primary coniguration of the veriier is done through the Setup 

section. From the Command window choose Options then Setup or press F5.

General

Standards: Click on ISO if you want only the numeric ISO result to be shown – or 

click on ANSI if you would prefer to be shown both results. The default is to track 

the Windows settings for metric or imperial measurements – alternatively you can 

set this as required. 

Pass Grade: If you are working with GS1 barcodes then the Apply GS1 General 

Speciications should remain ticked. The user can select the pass/fail grade for 

other barcode types as speciied either by an industry application speciication or 
by their customer.

Check Characters

This tab allows the user 

to select the barcode 

types that have 

optional check digits. 

If these are being used 

then the veriier can be 
set to validate them.

Appearance

This tab can be used 

to adjust any display 
colours/shades for the 

pass, warning and fail 

messages – and can 

also be used to add 

Windows wave sounds 

to give an audible 

indication of quality.
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Setup
Printing

This tab can be used 

to pre-select any 

particular reports that 

are required. This 

includes the option to 

have a personalised 

report generated 

through the built-in 

Report Generator. 

The veriier software 
can also be set to 

Autoprint to avoid 

forgetting to print a 

particular report. 

 Tick Print graph in black & white if you are using a monochrome (black and white) 

printer, otherwise a scan relectance proile will only show the outline and not 
the detail. Also, the standard printed report can be personalised if required using 

the Report header 

feature.

Logging

The Logging tab is 

used to set the saving 

of records and to run 

pre-conigured external 
programs from the 

veriier.
If the Enable box is 

ticked under the Auto 

Save Scan File section 

(at the top) then the 

software will auto save 

every scan ile in the chosen directory. 

The iles saved through this process can be regarded as audit quality records of the 
veriications made and can also be used for remote diagnostics purposes. The iles 
can be saved automatically with a ilename comprising the decoded number, date 
and time and a sequential number, or by using a dialogue box.

Save File Log allows users to run any Windows program each time a ile is saved. It 
is intended for use with RepGen or ScanDB, but could be used to perform any action 

on the saved ile.

Simple CSV File allows a subset of the scan information to be automatically 

appended to the speciied ile in CSV format.

Calibration

The Calibration tab 

speciies the ile and 
directory in which 

calibration data will 

be saved. This can be 

altered by clicking 

on the browse button 

and choosing the 

required directory 

and ilename. If Allow 

scans after calibration 

has expired is not 

ticked, no scans will 

be allowed until the 

veriier has been calibrated. Within the Allowed Calibration Codes is a list of the 

data content of barcodes with which calibration is permitted
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Advanced

There are several 

settings in the 

Advanced tab. If a 

barcode is such a poor 

quality that the veriier 
cannot decode it then 

there is an option to 

manually input the 

barcode under When 

barcode cannot be 

decoded. Use RepGen 

for CSV ile save is 

ticked by default: this 

means that simple CSV ile saving is performed using repgen.exe and the supplied 
template ile csv-template.txt.

UPC/EAN magniication factor is for users using the discontinued Axicon 5000 

veriier. 

The Password for Setup allows password protection of the settings in the Setup 

dialogue. This is useful for ensuring features such as the Pass/Fail grade and ile 
saving directories can only be altered by an authorised user. To apply a setup 

password, enter it in the Password for Setup box and click OK. You will be asked to 

re-enter the password you gave. Now, to alter the settings you must enter the same 

password into the Password for Setup again before you click OK. 

Setup
Plugins

The Plugins tab 

allows the software 

to be tailored to 

industry speciic or 
user speciic features, 
such as running 

a product lookup 

database, validation 

of the structure of 

variable weight items, 

or identifying the 

formats of European 

pharmaceutical codes – 

and a whole lot more.

The Plugins can be installed from the CD by using the Install Optional Plugins or 

can be downloaded from our website. An explanation of what each plugin does is on 

our website www.axicon.com/plugins.

Email

The Email tab allows 

scan iles to be 
emailed. Users can 

conigure the From: 

and Destination 

address, and the email 

server to be used. You 

can also enter the text 

to be used in the email 

body here.
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Software licence agreement
This software is Copyright © 1995 - 2016 

Use of the software is subject to the Axicon software licence terms set out below. 
Using the software indicates your acceptance of these licence terms. If you do not 

accept these within 14 days, you may return the entire unused product for a full 

refund. 

Axicon grants you a licence to use any number of copies of the software, but only 

for use with an Axicon veriier. “Use” means storing, loading, installing, executing 
or displaying the software. You may not modify the software or disable any of its 

licensing or control features.

Ownership

The software is owned and copyrighted by Axicon Auto ID Limited. Your licence 

confers no title or ownership in the software and is not a sale of rights in the 

software.

Copies

You may only make copies of the software for archival purposes or when copying is 

an essential step in its use. You must reproduce all copyright notices in the original 

software on all copies. You may not copy the software onto a bulletin board or 

similar publicly accessible system.

No disassembly or decryption

You may not disassemble or decompile the software without prior written consent 

from Axicon.

Transfer

Your licence will automatically terminate upon any transfer of the software. 

Upon transfer, you must deliver the software, including any copies and related 

documentation, to the transferee. The transferee must accept these licence terms 

as a condition of the transfer.

Termination

Axicon may terminate your licence upon notice of failure to comply with any 

of these terms. Upon termination, you must immediately destroy the software, 

together with all copies, adaptations and merged portions in any form.

Export requirements

You may not export or re-export the software in contravention of any applicable 

laws or regulations.

This agreement should be construed in accordance with the laws of England.

DISCLAIMER 

In the following the expression “veriier” means the veriier hardware and the 
associated software.

 

We have taken care to ensure that this veriier is free from defects. However since 
we have no control over the circumstances in which you might use it you must 

satisfy yourself that it is suitable for your needs. Neither Axicon Auto ID Limited 

nor the vendor of this veriier can accept any liability for any loss or damage 
(consequential or otherwise) which may be caused by its use. 

If the veriier or any part of it is defective in any way, or in some other way does 
not meet your expectations, the liability of Axicon Auto ID Limited is limited to the 

cost of the product. You should bear this limitation in mind if you use this veriier 
in any situations where the acceptance or rejection of shipments of goods or your 
reputation may depend upon the quality of a barcode.
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Warranty
All Axicon products covered by this documentation (Axicon 6000, 6500 and 7000 

series veriiers) are sold with a two year parts and labour warranty against 
manufacturing defects. This is a return to bench warranty with shipping costs in one 

direction being borne by the customer/distributor.

Should you need to return the unit to Axicon the original case (plus appropriate 

packaging) must be used. If the equipment is returned without the original case, we 

will automatically charge an additional sum for its replacement.

Axicon’s standard repair turnaround time is 7-10 working days. This standard 

warranty does not include the provision of a loan unit. Loan units can be supplied 

on request.

Axicon reserves the right to charge an inspection fee for any equipment returned 

under warranty for which no fault is found. Please contact us to obtain an RMA 
number before returning any equipment. This number must be quoted on all 

documentation. We cannot accept responsibility for equipment returned without an 

RMA number.

Maintenance agreement
A service contract may be purchased within 30 days from the date of despatch. This 

allows you to return your veriier back to us at no extra cost for its annual VCAS 
(veriier calibration and alignment service) so that you can be sure it still measures 
barcode quality in accordance with the requirements of ISO/IEC 15426-1.

The service contract will also extend the warranty beyond two years, so that if it 

breaks down, all parts and labour will be provided free of any extra charges. The 

only exception is when the veriier has been misused, in which case labour costs 
will be covered, but not those of the parts.
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Factory re-calibration
All veriiers need servicing every year to ensure that they measure barcode quality 
in accordance with the relevant ISO/IEC standards. This veriier calibration and 
alignment service (VCAS) ensures that the veriier is internally dust-free, checks 
that it is focused correctly, and re-calibrates the hardware to account for any 

change in the brightness of the LEDs used to illuminate the barcodes.

This factory re-calibration is not the same as user calibration, as it looks at the 

output of the LEDs and corrects for any variance in their evenness of illumination 

across the whole ield of view. Over time the LEDs will fade but they will not 
fade uniformly. User calibration ensures that the veriier is measuring the darkest 
and brightest relectances correctly but it cannot correct for any variance in the 
illumination.

After your veriier has been serviced, we will return it you with the latest version of 
the software on CD together with a new calibration card, and a new user guide that 

will include the new certiicate of ISO/IEC conformance. The latest software can 
always be downloaded free of charge from our website, www.axicon.com.

To arrange for your veriier to be serviced:

1. Contact us on 

 Telephone: +44 (0) 1869 351155 | Fax +44 (0) 1869 352404 

 Email: vcas@axicon.com

2. We will provide you with an RMA number (Return to Manufacturer Authority)  
 and an RMA form.
3. Please ill in all details requested on the RMA form, including the RMA number.
4. Return the veriier (including all cables) in its original case with the completed  
 RMA form, purchase order and your payment details to us at Axicon Auto ID  
 Ltd, Church Road, Weston on the Green, Oxfordshire OX25 3QP. We cannot take  

 responsibility for units returned in alternative packaging.

5. We will normally complete the service and re-calibration of your veriier within  
 7-10 days.

Certiicate of ISO/IEC 
conformance

We, Axicon Auto ID Limited, of Church Road, Weston on the Green, Oxfordshire, 

OX25 3QP, UK, hereby declare, that the following barcode veriier(s):

Model number(s)

Serial number(s)

has been designed and manufactured at our address in the UK to verify barcode 

quality and to conform to: ISO/IEC 15426-1 Barcode veriier conformance 
speciication - Part 1: Linear symbols.

The equipment has been tested and calibrated using primary reference test 

symbols traceable to the USA’s National Institute of Standards and Technology’s 

relectance standards. We also state that this equipment, when used with the 
latest veriier software, and conigured appropriately has the features to meet 
the requirements of the United States Food and Drug Administration regulation, 

Title 21 CFR Part 11.

This veriier has been quality assurance checked today, and conforms to this 
ISO/IEC standard. This declaration of conformity is valid for a year.

Issue date

Expiry date

Authorised signatory

Signatory Name

At or before the expiry date the veriier should be returned to Axicon for its 
annual servicing and factory re-calibration. This VCAS (veriier calibration and 
alignment service) will ensure that the veriier remains conformant to ISO/IEC 
15426-1 for another year.

Page 26 of 28 Page 27 of 28

Axicon Auto ID Limited  |  Linear veriier user guide | March 2016Axicon Auto ID Limited  |  Linear veriier user guide | March 2016

Church Road, Weston on the Green, 

Oxfordshire, OX25 3QP, UK

Axicon 6000, 6500, 7000 series



Contact us

Axicon Auto ID Ltd 

Church Road

Weston on the Green

Oxfordshire 

OX25 3QP

UK

Tel:  +44 (0) 1869 351 155

Fax:  +44 (0) 1869 351 205

Email:  info@axicon.com

Website: www.axicon.com

As Axicon continually improves its products, their speciications and features are 
subject to change without notice. All trademarks are acknowledged as belonging to 
their respective companies.

Your Axicon distributor


